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Chapter 1
Introduction

In this chapter, you will obtain a general overview of managing requirements and you will learn 
about the different windows in the ReqTracer application.

Product Overview
ReqTracer is a requirements traceability solution that links your development and verification 
documents with formal requirements stored in documents and databases.

Most engineering projects start by defining high-level specifications, followed by more 
specifications as the project progresses. Specifications contain technical and procedural 
requirements that guide the product through each engineering phase. In addition, working 
documents, such as hardware schematics, simulation models, software source code 
specifications and procedures must adhere to and cover the requirements defined by 
specifications.

ReqTracer allows you to configure which specification and working documents to process, the 
type of traceability information to obtain from each type of document, and the traceability 
relationship between these documents. ReqTracer performs the coverage and impact analysis, 
graphically displays relationships between documents and generates reports. ReqTracer 
improves the impact analysis throughout a project lifecycle and the quality by managing 
requirements traceability.

ReqTracer is an effective solution for enhancing project management traceability information, 
coming from any source.

ReqTracer includes the following features:

• Manage project documents and graphically create traceability relationships between 
documents

• Customize types for importing various types of data from third party products

• Use graphical, coverage analysis and impact analysis views to visualize and analyze 
traceability relationships between documents

• Create filters to customize analysis and displays

• Capture and compare project snapshots to determine changes in requirements and 
coverage

• Generate reports using default and custom templates
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Learning ReqTracer
The best way to familiarize yourself with ReqTracer is to complete the following tasks:

• Read this Getting Started guide to start with the main windows, concepts and features.

• Train yourself with the Getting Started example.

• Review the other sections in the User Manual and familiarize yourself with all the 
windows, features and analysis results calculations. 
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Chapter 2
Starting ReqTracer

When you launch ReqTracer, the main window appears:

Main Window
The main window has four main parts: the menu bar, the toolbar, the project workspace, and the 
status bar.

Menu Bar
The menu bar contains the following menus: File, Edit, View, Tools, Reports and Help. Browse 
the menus in the main window to familiarize yourself with their contents. The status bar will 
display a brief explanation of the menu item as you hover over it with the mouse.

Toolbar
The toolbar contains shortcuts to commonly used selections of the menu bar. As shown below, 
the toolbar contains the following sections: Standard, Configuration, Navigation, View 
Options, Filtering and Third Party.
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• Standard and Access Control (1) — Contains buttons for creating, loading and saving 
project files. Save is locked by user during modifications

• Configuration (2) — Contains buttons for configuring projects, types, snapshots and 
options. Plug-ins can be added there.

• Navigation (3) — Contains buttons for applying navigation commands previously 
performed within the coverage information of the Coverage Analysis, Impact Analysis 
views, Graphical View and Requirement Details. It is only available for these views.

• View Options (4) — Contains buttons to control which requirement elements are visible 
in the Coverage Analysis, and Impact Analysis views.

• Filtering (5) — Contains the Filter drop-down list box to configure and apply filters. 
These filters specify the conditions by which to include requirements in analysis or 
views.

• Third Party Tools and Plug-ins (6) — Contains additional buttons that apply to specific 
third party products, such as DOORS, and/or plug-ins.

Project Workspace
The project workspace is the main area of the application. This area displays the project 
information and analysis for the loaded project. The project workspace contains multiple view 
tabs for displaying the contents of the project. Each view may contain one or more panes.

The project workspace contains the following views:

• Management View — Displays the documents in the project and a summary of 
coverage information for the project.

• Coverage Analysis View — Displays all levels of covering elements, N-m, and all 
levels of covered elements, N+p, for a selected element of a document. These covered 
and covering elements come from other documents as defined by the project.

• Impact Analysis View — Displays one level of covering elements, N-1, and one level 
of covered elements, N+1, for a selected element of a document. These covered and 
covering elements come from other documents as defined by the project.

• Graphical View — Displays each document graphically using a tree view with lines 
connecting requirement elements in documents and covering elements in other 
documents.

• Requirement Details — Displays each requirement and its attributes for a document in 
a table.

• Link Details — Displays covering information between a covering document and its 
covered documents. 
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Status Bar
The status bar displays common information in the application, such as descriptions for menus 
or status while performing analysis.

Configuration Dialog Box
ReqTracer launches the Configuration dialog box when you select a menu item or toolbar 
button to configure one of the following parts of your project: Project, Types, Snapshots, 
Filters, Reports, Expressions, XML or Options.

The Configuration dialog box contains the following panes:

• Project — Allows you to configure the project by specifying the documents to include, 
the type of each document, and the covering relationship between documents. Refer to 
the Project Configuration chapter in the User Manual for more information about 
configuring projects.

• Types — Allows you to create new types or customize existing types for your project. 
Refer to the Customization Guide for more information about customizing types.
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• Snapshots — Allows you to create, manage and compare snapshots of your project. 
Refer to the Managing Snapshots chapter in the User Manual for more information 
about using snapshots.

• Filters — Allows you to define custom filters to analyze requirements and only display 
requirements from documents that meet specific criteria. You can enable filters using 
the Filter drop-down list box on the toolbar of the ReqTracer main window. Refer to the 
Filter section in the User Manual for more information about using filters.

• Reports — Allows you to define new custom reports. You can generate a default report 
or a custom report using the Reports> Library Reports submenu on the main window. 
Refer to the Generating Documentation chapter in this Manual, and to the User Manual 
for more information about generating documents.

• Expressions — Allows you to test regular expressions. You can specify source text and 
a regular expression, and the pane will display the captured text returned by the regular 
expression.

• XML — Allows you to test XML syntaxes. You can specify source text and an XML 
syntax, and the pane will display the captured text returned by the XML syntax.

• Options — Allows you to set the default font for text in the application, set the 
password on the project, and define environmental variables and other miscellaneous 
settings for the application. 
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Chapter 3
Managing Requirements

In this chapter, you will learn about the different windows in ReqTracer by creating a project, 
adding existing documents to the project and reviewing the contents of the documents and the 
views in ReqTracer.

A project specifies the documents that ReqTracer analyzes and displays, as well as the type of 
each document. A type defines how to select external files that represent a document, how to 
read the contents of the external files, how to interpret the contents as elements for managing 
requirements and how to display the elements of the document.

Creating a Project
The exercises in this manual use the files located in the <ReqTracer>\examples\Use 
Cases\Getting Started directory. A Tutorial project example is delivered in this directory.

To create your own Tutorial project, you will start the ReqTracer application and create a new 
project. You will add and configure documents in the project, review the contents of the 
documents and review the views in the ReqTracer project workspace.

1. Launch the ReqTracer application by selecting Start > Programs > <ReqTracer 
group> > ReqTracer. You will now see the ReqTracer main window.

2. Select File > New… to launch the Create a New Project and Save As dialog box and 
create the project.

3. Enter MyTutorial in the File name field, select the directory to create the project then 
click Save.

4. ReqTracer creates a new project file MyTutorial.rtqf in the selected directory and 
displays the Project pane of the Configuration dialog box as shown in the following 
figure.
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A project file defines the documents in which ReqTracer will read the type of each 
document and the covering relationship between these documents.

Adding a Document
After you create your project, you will add a Microsoft Word specification document to the 
project.

1. Click the Add a document button. When you make this selection, the cursor 
automatically moves to the Traceability Description Area and the cursor outlines a 
document object. Click within this area to place the document. When you place the 
document, the document is added to the Project Tree pane. The Document Details Area 
displays the settings for the selected document.

2. In the Document Details Area, click on the Name column to select the Document1 text. 
Type Product Specification and press <Enter> to rename the document. The name 
in the document object now displays the new name.

3. Click on the Type of Analysis column. Select Word in the drop-down list box.

4. Click on the File or Directory column. The File Browse button appears on the right side 
of the control. Click the File Browse button and select <ReqTracer>\examples\Use 
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Cases\Getting Started\ProductSpec.doc. The following figure shows the 
completed Configuration dialog box.

Adding a Covering Document
A covering document is a document that contains references to requirements that are defined 
in another document. You will now add a new document to the project that covers the Product 
Specification document.

1. Click the Add a document button to add a second document object in the Traceability 
Description Area. Place the document below the Product Specification document.

2. In the Document Details Area, configure the document as follows:

o Name: Design Specification

o Type of Analysis: Word

o File or Directory: <ReqTracer>\examples\Use Cases\Getting 
Started\CoveringSpec.doc

3. Click the Add a cover button. The cursor moves to the Traceability Description Area. 
Click the Design Specification document object first and then click the Product 
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Specification document object. An arrow appears between the two documents as 
shown in the following figure. This arrow indicates that the Design Specification 
document covers the Product Specification document.

4. Click OK to save and close the Configuration dialog box.
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Using the Management View
After you close the Configuration dialog box, the main window appears as shown in the 
following figure.

The Management View displays the project in the Project Overview area. The project has two 
documents and its coverage ratios is 83%. 

The Overall Quality pane indicates that the project has six requirements defined and one error 
which is an uncovered requirement. The percentage of requirements without errors is 83%.

Perform the following tasks to acquaint yourself with the Management View and the 
documents that you have included in the project.

1. Right click the Product Specification in the Project Overview and select Navigate 
from the context menu. ReqTracer displays the ProductSpec.doc file in Microsoft 
Word.

2. Review the contents of the file in Word. The file contains three types of elements: 
sections, requirements and text. The default Word type in ReqTracer interprets the 
contents of the file as follows:

o A section is defined by Word heading styles.

o A requirement is defined using the Word style “Requirement_ID”. This can be 
customized to capture an identifier that contains a set of arbitrary characters, and 
ends with a numeric value. The label for the requirement is after the identifier and is 
delimited by a colon character.
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o Any text using the Word style “Requirement_Text” is associated with the previously 
specified element. If an initial text element is specified at the beginning of the file, 
the text is associated with the document.

o The ProductSpec.doc file specifies six requirements. The document can be closed.

3. In ReqTracer, right-click the Design Specification in the Project Overview and select 
Navigate from the context menu. ReqTracer displays the CoveringSpec.doc file in 
Word.

4. Review the contents of the CoveringSpec.doc file in Word. The file contains section 
and text elements, but instead of requirement elements, the file contains requirement 
references. A requirement reference is defined by the prefix characters [Covers:, 
followed by a set of characters that represent the requirement identifier, and completed 
with a closing bracket character.
The CoveringSpec.doc file specifies five requirement references. Notice that the 1.2. 
USB 2.0 Speeds section of the document does not contain a requirement reference. This 
missing reference is discussed later in this exercise. The document can be closed.
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Chapter 4
Analyzing Requirements

As explained in the previous chapter, Managing Requirements, the Management View 
summarizes the structure of the project and the coverage ratios. This chapter will teach you how 
to use the Coverage Analysis View, the Impact Analysis View and the Graphical View to 
obtain additional details about the requirements and the references that cover them.

Analyzing the Project
Complete the following steps to analyze requirement coverage for the project that you created 
in the Managing Requirements chapter.

1. Select the Coverage Analysis View tab in the main window. Ensure that the Product 
Specification and the Design Specification document elements in the Selection 
tree view pane are collapsed.

2. Click the Product Specification document element in the Selection column.

3. The Downstream Coverage Information column displays that the Product 
Specification document is covered by the Design Specification document, and 
the document covers only 83% of the requirements.

4. Expand the child elements of the Product Specification document in the Selection 
column.
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Note
To expand a parent element and all its child elements, press <Shift> while clicking the 
plus icon to expand the parent element.

The tree view pane displays the section headings from the text file as parent elements 
and displays the requirements as child elements.

5. Select the PS_USB_REQ1 requirement. The PS_USB_REQ1 element represents a 
requirement specified in the document. Select the Messages tab which indicates that the 
PS_USB_REQ1 element is a requirement and that this requirement is covered. The 
Downstream Coverage Information column displays the 1.1 USB 1.0 Speeds 
section as a covering element because this section of the document contains a reference 
to the requirement. The tree view pane also includes the parent 1 USB Support section 
of the covering document.

6. Select the PS_USB_REQ2 requirement. The Messages tab indicates that the PS_USB_REQ2 
element is also a requirement; however, this requirement is not covered. ReqTracer 
highlights the name of the element in red. The Downstream Coverage Information 
column does not display any covering elements because the covering document does not 
contain a reference to the requirement.
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Collapse the Product Specification document in the tree view pane of the Coverage 
Analysis View.

7. Select the root element of the Design Specification document. The Messages tab 
indicates that the document contains references to five requirements.

8. Expand the child elements of the Design Specification document in the tree view 
pane, as shown in the following figure.

9. Select the 1.1 USB 1.0 Speeds element in the tree. This element represents a section 
specified in the document. The Messages tab indicates that the section contains a 
reference to one requirement.

10. Select the 1.2 USB 2.0 Speeds element in the tree. The Messages tab for this element 
indicates that the section is empty and contains no references to any requirements.

11. Collapse the Design Specification document in the tree view pane of the Coverage 
Analysis View.

12. Expand the elements of the Rule check item of the Coverage Analysis View as shown 
in the following figure. The Rule check tree contains a summary of the rules flagged 
while analyzing the project. For this project, the pane indicates that the PS_USB_REQ2 
requirement is uncovered.

Refer to the Rules Check and Error Messages chapter of the User Manual for more information 
concerning the various rules that ReqTracer defines.

Using the Coverage Analysis View
The Coverage Analysis View displays the immediate downstream and upstream document. In 
this section, you will learn how to add a cover to the project and how to use the Coverage 
Analysis View.
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Adding a Cover
Complete the following steps to add a cover to the project that you created in the Managing 
Requirements chapter.

1. Expand the child elements of the Product Specification document in the Selection 
column of the Coverage Analysis View.

2. Fly over the exclamation icon, to the right of the PS_USB_REQ2 requirement to display a 
tip strip that contains the text, 1 uncovered requirement. The tree view pane displays 
the exclamation icon for an uncovered requirement and its parent elements in the 
document.

3. Click the Analog Channels section as shown in the following figure. The child 
elements of the Analog Channels section contain two requirements: PS_AI_REQ1 and 
PS_AO_REQ1. The Downstream Coverage Information column displays both the 2.1 
Analog Input and the 2.2 Analog Output sections as covering elements. In the 
covering document, the 2.1 Analog Input section contains a reference to the 
PS_AI_REQ1 requirement and the 2.2 Analog Output section contains a reference to 
the PS_AO_REQ1 requirement.

4. Double-click the 2.1 Analog Input section in the Downstream Coverage 
Information column. ReqTracer navigates to the 2.1 Analog Input section in the 
Selection column. The Upstream Coverage Information column displays that 83% of 
the requirements in the Product Specification document are covered by the Design 
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Specification document, and that the PS_AI_REQ1 requirement is specifically covered 
by references from the 2.1 Analog Input section in the Selection column.

5. Expand the 1 USB Support element of the Design Specification document to view 
the 1.2 USB 2.0 Speeds element.

6. Double-click the 1.2 USB 2.0 Speeds element in the Selection column to open the 
CoveringSpec.doc file in Word.

7. Edit the file by adding a reference to the PS_AI_REQ2 requirement below the 1.2 USB 
2.0 Speeds section as shown in the following figure.

8. Save the changes to the CoveringSpec.doc file.

9. Return to ReqTracer. When the main window of ReqTracer is displayed, the application 
prompts you indicating that the Design Specification document was modified. Click 
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Yes to reload the file. ReqTracer analyzes the new document and updates the view as 
shown in the following figure.

The Upstream Coverage Information column now indicates that the Design 
Specification covers 100% of the requirements in the Product Specification 
document, the PS_USB_REQ2 requirement is now shown as covered by the 1.2 USB 2.0 
Speeds element, and the orange icon for the 1.2 USB 2.0 Speeds element and its 
parent elements indicate a change occurred.

In summary, the Coverage Analysis View allows you to select elements from a project 
document and displays requirement coverage one level upstream and one level downstream 
from the selected document.

In the next section, you will learn how to use the Impact Analysis View.

Using the Impact Analysis View
The Impact Analysis View displays traceability information from all downstream and 
upstream documents instead of only displaying the immediate downstream and upstream 
document. In this chapter, you will learn how to add a third document to the project and how to 
use the Impact Analysis View.

Modifying a Document
Complete the following steps to modify an existing document to the project that you created in 
the Managing Requirements chapter.

1. Select File> Edit Project to launch the Project pane of the Configuration dialog box.

2. Click the Design Specification object in the Traceability Description Area.

3. In the Document Details Area, reconfigure the document as follows:

o Name — Design Specification

o Type of Analysis — Word
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o File or Directory — <ReqTracer>\examples\Use Cases\Getting 
Started\DesignSpec.doc

Adding a Second Downstream Document
Add a third document to the project.

1. From the Project editor, click the Add a document button to add a third document 
object in the Traceability Description Area. Place the document below the second 
document.

2. In the Document Details Area, configure the document as follows:

o Name — Test Specification

o Type of Analysis — Word

o File or Directory — <ReqTracer>\examples\Use Cases 
\GettingStarted\TestSpec.doc

3. Click the Add a cover button to add a covering link. Click the Test Specification 
document object first and then click the Design Specification document object to 
create an arrow between the two documents, as shown in the following figure.
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4. Click OK to save and close the Configuration dialog box. Click Yes when ReqTracer 
prompts you to reanalyze the project. Your new project is now properly configured to 
analyze the new documents.

Return to the ReqTracer main window and select the Impact Analysis View tab. Collapse the 
three document elements in the Selection column.

Reviewing the New Documents
Complete the following steps to review the contents of the two new documents.

1. Double-click the Design Specification element in the Selection column to display 
the DesignSpec.doc file in Word.

2. Review the contents of the file in Word. The DesignSpec.doc file contains similar 
sections and text elements as found in the CoveringSpec.doc file, however the 
DesignSpec.doc file also contains 24 additional requirements. These additional 
requirements are covered by references in the Test Specification document. The 
following figure displays the 1.1 USB 1.0 Speeds section of the file, which contains a 
reference to the PS_USB_REQ1 requirement and contains two additional derived 
requirements, DS_USB1_REQ1 and DS_USB1_REQ2. A derived requirement is a 
requirement that is defined in a document but is not directly associated with the 
coverage of an upstream document.

To associate a requirement with the coverage of an upstream document, the requirement 
must be specified immediately before the reference that covers the upstream document 
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as shown in the following figure. These requirements are sometimes referred to as non-
derived or low-level or design requirements.

ReqTracer displays derived and non-derived requirements in the Impact Analysis 
View.

3. Double-click the Test Specification element in the Selection column to open the 
TestSpec.doc file in Word. Review the contents of the file in Word. The 
TestSpec.doc file contains references for 24 requirements specified in the Design 
Specification document.

Performing Impact Analysis
Complete the following steps to learn how to analyze the new documents using the Impact 
Analysis View.

1. Expand the Design Specification document in the Selection column, as shown in the 
following figure, to display the derived requirements, DS_USB1_REQ1 and 
DS_USB1_REQ2, and the non-derived requirements, DS_USB2_REQ1, DS_USB2_REQ2 and 
DS_USB2_REQ3.
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ReqTracer displays different icons for derived and non-derived requirements and 
displays a navigation arrow icon on the right side of the column to highlight derived 
requirements. Derived requirements are also added to the Rule check information.

The icon  indicates that an error exists. In this example, the error is :"The target 
requirement of reference PS_AO_REQ199 has not been found anywhere in the project".

2. Expand the Product Specification document, as shown in the following figure, and 
select the PS_USB_REQ1 requirement. The Downstream Impact Information column 
displays the covering 1.1 USB 1.0 Speeds section from the Design Specification 
document.

3. Select the PS_USB_REQ2 requirement as shown in the following figure. The 
Downstream Impact Information column displays the non-derived requirements from 
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the covering Design Specification document. It also shows the sections from the 
Test Specification document that covers the non-derived requirements.

In the next section, you will learn how to graphically view traceability information.

Using the Graphical View
Complete the following steps to graphically view your project documents.

1. Select the Graphical View tab. The Graphical View displays each document as an 
object with its traceability elements displayed in a tree view within the object. Thin, 
black lines represent covering references between requirements elements of a document 
and elements in another document. You can also reposition documents, adjust the width 
of the documents, pan, zoom and resize the containing page.

2. Click the PS_USB_REQ2 element in the Product Specification document. When you 
make this selection, the view highlights the PS_USB_REQ2 element, the covering 
DS_USB2_REQ1, DS_USB2_REQ2 and DS_USB2_REQ3 requirements, their coverage by 
Test Specification and the lines between the elements, as shown in the following 
figure.
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3. Right-click the PS_USB_REQ2 requirement and select View Graph for Selection from 
the context menu. When you make this selection, the view only displays the highlighted 
elements from the three documents, as shown in the following figure.

4. Right-click in the view and select Show All Elements from the context menu to show 
all the elements of the documents again.

Below are listed some actions to perform within the Graphical View.

• Click the header of the Test Specification document. When you make this selection, 
the entire document is selected.

• Right-click the Test Specification document and select Hide Selected Documents 
from the context menu. When you make this selection, the view hides the Test 
Specification document and displays the traceability information for the remaining 
two documents.

• Right-click in the view and select Show Hidden Elements in the context menu to 
display all the documents again. A dialog opens to select the document to show again.

• Move documents within the Graphical View by selecting the document header and 
dragging the header to a new location.

• Zoom in and out by pressing <Ctrl> while rolling your mouse wheel up or down. You 
can also select either Zoom > 100% or Zoom > Fit in page from the context menu.

• Resize the width of a document by selecting the document header and dragging the 
resize handles that appear on the right side of the document. Consult following figure.

• Expand and collapse the sections by clicking the plus sign. You can also right-click the 
header of a document and select Collapse Root Sections or Expand All Sections from 
the context menu, as shown in the following figure.
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In the next chapter you will learn how to generate reports for a project.
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Chapter 5
Generating Reports

In this chapter you will learn how to generate reports and create customized reports.

Generating a Built-in Report
ReqTracer installs the following Library Reports:

• Traceability Matrix — Lists the upstream to downstream covered links and the 
downstream to upstream covering links.

• Analysis Results — Summarizes the coverage analysis for a project.

• Project Description — Describes the project and its documents.

• Upstream Impact Analysis — Lists the upstream traceability information for selected 
elements of the project.

• Downstream Impact Analysis — Lists the downstream traceability information for 
selected elements of the project.

• Synthesis of Added Information — Summarizes any added attributes, references, text 
and covering links in the project.

• Rules Checking — Contains a summary of any rules highlighted by the project.

Complete the following steps to generate a Project Description report for your project.

1. Select Reports > Library Reports > Project Description to display the Save As dialog 
box.
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2. Enter ProjectDescription.rtf in the filename control and click Save. ReqTracer 
generates and displays the report file in Microsoft WordPad or Microsoft Word, as 
shown in the following figure. Review the contents of the report.

You have completed this tutorial. Refer to the User Manual for more detailed information about 
all the windows, features and concepts introduced here.

We started with a demo example that is very simple, but consistent with what you can 
experiment when you switch to a more complex process for requirements management:

• More advanced and more specific Types of analysis can be created using the 
Customization Guide. Those types can be used to analyze Word files, as well as 
information from other text processing tools, requirements management tools (DOORS, 
RequisitePro, etc.), modeling tools, verification tools, code files and so on. However, for 
users project there still exists ready-to-use types like the “Word” one used in this 
tutorial.

• More advanced processes can be defined, with a larger number of documents and more 
complex relationships, but you will have to use the same Project Editor window, and use 
the same feature to add new documents, new coverage links, etc.
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END-USER LICENSE AGREEMENT (“Agreement”)

This is a legal agreement concerning the use of Software (as defined in Section 2) and hardware (collectively “Products”)
between the company acquiring the Products (“Customer”), and the Mentor Graphics entity that issued the corresponding
quotation or, if no quotation was issued, the applicable local Mentor Graphics entity (“Mentor Graphics”). Except for license
agreements related to the subject matter of this license agreement which are physically signed by Customer and an authorized
representative of Mentor Graphics, this Agreement and the applicable quotation contain the parties’ entire understanding
relating to the subject matter and supersede all prior or contemporaneous agreements. If Customer does not agree to these
terms and conditions, promptly return or, in the case of Software received electronically, certify destruction of Software and all
accompanying items within five days after receipt of Software and receive a full refund of any license fee paid.

1. ORDERS, FEES AND PAYMENT. 

1.1. To the extent Customer (or if agreed by Mentor Graphics, Customer’s appointed third party buying agent) places and Mentor
Graphics accepts purchase orders pursuant to this Agreement (each an “Order”), each Order will constitute a contract between
Customer and Mentor Graphics, which shall be governed solely and exclusively by the terms and conditions of this Agreement,
any applicable addenda and the applicable quotation, whether or not those documents are referenced on the Order. Any additional
or conflicting terms and conditions appearing on an Order or presented in any electronic portal or automated order management
system, whether or not required to be electronically accepted, will not be effective unless agreed in writing and physically signed
by an authorized representative of Customer and Mentor Graphics.

1.2. Amounts invoiced will be paid, in the currency specified on the applicable invoice, within 30 days from the date of such invoice.
Any past due invoices will be subject to the imposition of interest charges in the amount of one and one-half percent per month or
the applicable legal rate currently in effect, whichever is lower. Prices do not include freight, insurance, customs duties, taxes or
other similar charges, which Mentor Graphics will state separately in the applicable invoice. Unless timely provided with a valid
certificate of exemption or other evidence that items are not taxable, Mentor Graphics will invoice Customer for all applicable
taxes including, but not limited to, VAT, GST, sales tax, consumption tax and service tax. Customer will make all payments free
and clear of, and without reduction for, any withholding or other taxes; any such taxes imposed on payments by Customer
hereunder will be Customer’s sole responsibility. If Customer appoints a third party to place purchase orders and/or make
payments on Customer’s behalf, Customer shall be liable for payment under Orders placed by such third party in the event of
default.

1.3. All Products are delivered FCA factory (Incoterms 2010), freight prepaid and invoiced to Customer, except Software delivered
electronically, which shall be deemed delivered when made available to Customer for download. Mentor Graphics retains a
security interest in all Products delivered under this Agreement, to secure payment of the purchase price of such Products, and
Customer agrees to sign any documents that Mentor Graphics determines to be necessary or convenient for use in filing or
perfecting such security interest. Mentor Graphics’ delivery of Software by electronic means is subject to Customer’s provision of
both a primary and an alternate e-mail address.

2. GRANT OF LICENSE. The software installed, downloaded, or otherwise acquired by Customer under this Agreement, including any
updates, modifications, revisions, copies, documentation and design data (“Software”) are copyrighted, trade secret and confidential
information of Mentor Graphics or its licensors, who maintain exclusive title to all Software and retain all rights not expressly granted
by this Agreement. Mentor Graphics grants to Customer, subject to payment of applicable license fees, a nontransferable, nonexclusive
license to use Software solely: (a) in machine-readable, object-code form (except as provided in Subsection 5.2); (b) for Customer’s
internal business purposes; (c) for the term of the license; and (d) on the computer hardware and at the site authorized by Mentor
Graphics. A site is restricted to a one-half mile (800 meter) radius. Customer may have Software temporarily used by an employee for
telecommuting purposes from locations other than a Customer office, such as the employee’s residence, an airport or hotel, provided
that such employee’s primary place of employment is the site where the Software is authorized for use. Mentor Graphics’ standard
policies and programs, which vary depending on Software, license fees paid or services purchased, apply to the following: (a)
relocation of Software; (b) use of Software, which may be limited, for example, to execution of a single session by a single user on the
authorized hardware or for a restricted period of time (such limitations may be technically implemented through the use of
authorization codes or similar devices); and (c) support services provided, including eligibility to receive telephone support, updates,
modifications, and revisions. For the avoidance of doubt, if Customer provides any feedback or requests any change or enhancement to
Products, whether in the course of receiving support or consulting services, evaluating Products, performing beta testing or otherwise,
any inventions, product improvements, modifications or developments made by Mentor Graphics (at Mentor Graphics’ sole discretion)
will be the exclusive property of Mentor Graphics.

3. ESC SOFTWARE. If Customer purchases a license to use development or prototyping tools of Mentor Graphics’ Embedded Software
Channel (“ESC”), Mentor Graphics grants to Customer a nontransferable, nonexclusive license to reproduce and distribute executable
files created using ESC compilers, including the ESC run-time libraries distributed with ESC C and C++ compiler Software that are
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linked into a composite program as an integral part of Customer’s compiled computer program, provided that Customer distributes
these files only in conjunction with Customer’s compiled computer program. Mentor Graphics does NOT grant Customer any right to
duplicate, incorporate or embed copies of Mentor Graphics’ real-time operating systems or other embedded software products into
Customer’s products or applications without first signing or otherwise agreeing to a separate agreement with Mentor Graphics for such
purpose.

4. BETA CODE. 

4.1. Portions or all of certain Software may contain code for experimental testing and evaluation (which may be either alpha or beta,
collectively “Beta Code”), which may not be used without Mentor Graphics’ explicit authorization. Upon Mentor Graphics’
authorization, Mentor Graphics grants to Customer a temporary, nontransferable, nonexclusive license for experimental use to test
and evaluate the Beta Code without charge for a limited period of time specified by Mentor Graphics. Mentor Graphics may
choose, at its sole discretion, not to release Beta Code commercially in any form.

4.2. If Mentor Graphics authorizes Customer to use the Beta Code, Customer agrees to evaluate and test the Beta Code under normal
conditions as directed by Mentor Graphics. Customer will contact Mentor Graphics periodically during Customer’s use of the
Beta Code to discuss any malfunctions or suggested improvements. Upon completion of Customer’s evaluation and testing,
Customer will send to Mentor Graphics a written evaluation of the Beta Code, including its strengths, weaknesses and
recommended improvements.

4.3. Customer agrees to maintain Beta Code in confidence and shall restrict access to the Beta Code, including the methods and
concepts utilized therein, solely to those employees and Customer location(s) authorized by Mentor Graphics to perform beta
testing. Customer agrees that any written evaluations and all inventions, product improvements, modifications or developments
that Mentor Graphics conceived or made during or subsequent to this Agreement, including those based partly or wholly on
Customer’s feedback, will be the exclusive property of Mentor Graphics. Mentor Graphics will have exclusive rights, title and
interest in all such property. The provisions of this Subsection 4.3 shall survive termination of this Agreement.

5. RESTRICTIONS ON USE. 

5.1. Customer may copy Software only as reasonably necessary to support the authorized use. Each copy must include all notices and
legends embedded in Software and affixed to its medium and container as received from Mentor Graphics. All copies shall remain
the property of Mentor Graphics or its licensors. Customer shall maintain a record of the number and primary location of all
copies of Software, including copies merged with other software, and shall make those records available to Mentor Graphics upon
request. Customer shall not make Products available in any form to any person other than Customer’s employees and on-site
contractors, excluding Mentor Graphics competitors, whose job performance requires access and who are under obligations of
confidentiality. Customer shall take appropriate action to protect the confidentiality of Products and ensure that any person
permitted access does not disclose or use Products except as permitted by this Agreement. Customer shall give Mentor Graphics
written notice of any unauthorized disclosure or use of the Products as soon as Customer becomes aware of such unauthorized
disclosure or use. Except as otherwise permitted for purposes of interoperability as specified by applicable and mandatory local
law, Customer shall not reverse-assemble, reverse-compile, reverse-engineer or in any way derive any source code from Software.
Log files, data files, rule files and script files generated by or for the Software (collectively “Files”), including without limitation
files containing Standard Verification Rule Format (“SVRF”) and Tcl Verification Format (“TVF”) which are Mentor Graphics’
trade secret and proprietary syntaxes for expressing process rules, constitute or include confidential information of Mentor
Graphics. Customer may share Files with third parties, excluding Mentor Graphics competitors, provided that the confidentiality
of such Files is protected by written agreement at least as well as Customer protects other information of a similar nature or
importance, but in any case with at least reasonable care. Customer may use Files containing SVRF or TVF only with Mentor
Graphics products. Under no circumstances shall Customer use Products or Files or allow their use for the purpose of developing,
enhancing or marketing any product that is in any way competitive with Products, or disclose to any third party the results of, or
information pertaining to, any benchmark.

5.2. If any Software or portions thereof are provided in source code form, Customer will use the source code only to correct software
errors and enhance or modify the Software for the authorized use. Customer shall not disclose or permit disclosure of source code,
in whole or in part, including any of its methods or concepts, to anyone except Customer’s employees or on-site contractors,
excluding Mentor Graphics competitors, with a need to know. Customer shall not copy or compile source code in any manner
except to support this authorized use.

5.3. Customer may not assign this Agreement or the rights and duties under it, or relocate, sublicense, or otherwise transfer the
Products, whether by operation of law or otherwise (“Attempted Transfer”), without Mentor Graphics’ prior written consent and
payment of Mentor Graphics’ then-current applicable relocation and/or transfer fees. Any Attempted Transfer without Mentor
Graphics’ prior written consent shall be a material breach of this Agreement and may, at Mentor Graphics’ option, result in the
immediate termination of the Agreement and/or the licenses granted under this Agreement. The terms of this Agreement,
including without limitation the licensing and assignment provisions, shall be binding upon Customer’s permitted successors in
interest and assigns.

5.4. The provisions of this Section 5 shall survive the termination of this Agreement.

6. SUPPORT SERVICES. To the extent Customer purchases support services, Mentor Graphics will provide Customer with updates and
technical support for the Products, at the Customer site(s) for which support is purchased, in accordance with Mentor Graphics’ then
current End-User Support Terms located at http://supportnet.mentor.com/supportterms.

7. LIMITED WARRANTY. 

7.1. Mentor Graphics warrants that during the warranty period its standard, generally supported Products, when properly installed, will
substantially conform to the functional specifications set forth in the applicable user manual. Mentor Graphics does not warrant
that Products will meet Customer’s requirements or that operation of Products will be uninterrupted or error free. The warranty
period is 90 days starting on the 15th day after delivery or upon installation, whichever first occurs. Customer must notify Mentor

http://supportnet.mentor.com/supportterms


Graphics in writing of any nonconformity within the warranty period. For the avoidance of doubt, this warranty applies only to the
initial shipment of Software under an Order and does not renew or reset, for example, with the delivery of (a) Software updates or
(b) authorization codes or alternate Software under a transaction involving Software re-mix. This warranty shall not be valid if
Products have been subject to misuse, unauthorized modification, improper installation or Customer is not in compliance with this
Agreement. MENTOR GRAPHICS’ ENTIRE LIABILITY AND CUSTOMER’S EXCLUSIVE REMEDY SHALL BE, AT
MENTOR GRAPHICS’ OPTION, EITHER (A) REFUND OF THE PRICE PAID UPON RETURN OF THE PRODUCTS TO
MENTOR GRAPHICS OR (B) MODIFICATION OR REPLACEMENT OF THE PRODUCTS THAT DO NOT MEET THIS
LIMITED WARRANTY. MENTOR GRAPHICS MAKES NO WARRANTIES WITH RESPECT TO: (A) SERVICES; (B)
PRODUCTS PROVIDED AT NO CHARGE; OR (C) BETA CODE; ALL OF WHICH ARE PROVIDED “AS IS.”

7.2. THE WARRANTIES SET FORTH IN THIS SECTION 7 ARE EXCLUSIVE. NEITHER MENTOR GRAPHICS NOR ITS
LICENSORS MAKE ANY OTHER WARRANTIES EXPRESS, IMPLIED OR STATUTORY, WITH RESPECT TO
PRODUCTS PROVIDED UNDER THIS AGREEMENT. MENTOR GRAPHICS AND ITS LICENSORS SPECIFICALLY
DISCLAIM ALL IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NON-INFRINGEMENT OF INTELLECTUAL PROPERTY.

8. LIMITATION OF LIABILITY. EXCEPT WHERE THIS EXCLUSION OR RESTRICTION OF LIABILITY WOULD BE VOID
OR INEFFECTIVE UNDER APPLICABLE LAW, IN NO EVENT SHALL MENTOR GRAPHICS OR ITS LICENSORS BE
LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES (INCLUDING LOST PROFITS OR
SAVINGS) WHETHER BASED ON CONTRACT, TORT OR ANY OTHER LEGAL THEORY, EVEN IF MENTOR GRAPHICS
OR ITS LICENSORS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL MENTOR
GRAPHICS’ OR ITS LICENSORS’ LIABILITY UNDER THIS AGREEMENT EXCEED THE AMOUNT RECEIVED FROM
CUSTOMER FOR THE HARDWARE, SOFTWARE LICENSE OR SERVICE GIVING RISE TO THE CLAIM. IN THE CASE
WHERE NO AMOUNT WAS PAID, MENTOR GRAPHICS AND ITS LICENSORS SHALL HAVE NO LIABILITY FOR ANY
DAMAGES WHATSOEVER. THE PROVISIONS OF THIS SECTION 8 SHALL SURVIVE THE TERMINATION OF THIS
AGREEMENT.

9. HAZARDOUS APPLICATIONS. CUSTOMER ACKNOWLEDGES IT IS SOLELY RESPONSIBLE FOR TESTING ITS
PRODUCTS USED IN APPLICATIONS WHERE THE FAILURE OR INACCURACY OF ITS PRODUCTS MIGHT RESULT IN
DEATH OR PERSONAL INJURY (“HAZARDOUS APPLICATIONS”). EXCEPT TO THE EXTENT THIS EXCLUSION OR
RESTRICTION OF LIABILITY WOULD BE VOID OR INEFFECTIVE UNDER APPLICABLE LAW, IN NO EVENT SHALL
MENTOR GRAPHICS OR ITS LICENSORS BE LIABLE FOR ANY DAMAGES RESULTING FROM OR IN CONNECTION
WITH THE USE OF MENTOR GRAPHICS PRODUCTS IN OR FOR HAZARDOUS APPLICATIONS. THE PROVISIONS OF
THIS SECTION 9 SHALL SURVIVE THE TERMINATION OF THIS AGREEMENT.

10. INDEMNIFICATION. CUSTOMER AGREES TO INDEMNIFY AND HOLD HARMLESS MENTOR GRAPHICS AND ITS
LICENSORS FROM ANY CLAIMS, LOSS, COST, DAMAGE, EXPENSE OR LIABILITY, INCLUDING ATTORNEYS’ FEES,
ARISING OUT OF OR IN CONNECTION WITH THE USE OF MENTOR GRAPHICS PRODUCTS IN OR FOR HAZARDOUS
APPLICATIONS. THE PROVISIONS OF THIS SECTION 10 SHALL SURVIVE THE TERMINATION OF THIS AGREEMENT.

11. INFRINGEMENT. 

11.1. Mentor Graphics will defend or settle, at its option and expense, any action brought against Customer in the United States,
Canada, Japan, or member state of the European Union which alleges that any standard, generally supported Product acquired by
Customer hereunder infringes a patent or copyright or misappropriates a trade secret in such jurisdiction. Mentor Graphics will
pay costs and damages finally awarded against Customer that are attributable to such action. Customer understands and agrees
that as conditions to Mentor Graphics’ obligations under this section Customer must: (a) notify Mentor Graphics promptly in
writing of the action; (b) provide Mentor Graphics all reasonable information and assistance to settle or defend the action; and (c)
grant Mentor Graphics sole authority and control of the defense or settlement of the action.

11.2. If a claim is made under Subsection 11.1 Mentor Graphics may, at its option and expense: (a) replace or modify the Product so
that it becomes noninfringing; (b) procure for Customer the right to continue using the Product; or (c) require the return of the
Product and refund to Customer any purchase price or license fee paid, less a reasonable allowance for use.

11.3. Mentor Graphics has no liability to Customer if the action is based upon: (a) the combination of Software or hardware with any
product not furnished by Mentor Graphics; (b) the modification of the Product other than by Mentor Graphics; (c) the use of other
than a current unaltered release of Software; (d) the use of the Product as part of an infringing process; (e) a product that Customer
makes, uses, or sells; (f) any Beta Code or Product provided at no charge; (g) any software provided by Mentor Graphics’
licensors who do not provide such indemnification to Mentor Graphics’ customers; or (h) infringement by Customer that is
deemed willful. In the case of (h), Customer shall reimburse Mentor Graphics for its reasonable attorney fees and other costs
related to the action.

11.4. THIS SECTION 11 IS SUBJECT TO SECTION 8 ABOVE AND STATES THE ENTIRE LIABILITY OF MENTOR
GRAPHICS AND ITS LICENSORS, AND CUSTOMER’S SOLE AND EXCLUSIVE REMEDY, FOR DEFENSE,
SETTLEMENT AND DAMAGES, WITH RESPECT TO ANY ALLEGED PATENT OR COPYRIGHT INFRINGEMENT OR
TRADE SECRET MISAPPROPRIATION BY ANY PRODUCT PROVIDED UNDER THIS AGREEMENT.

12. TERMINATION AND EFFECT OF TERMINATION. 

12.1. If a Software license was provided for limited term use, such license will automatically terminate at the end of the authorized
term. Mentor Graphics may terminate this Agreement and/or any license granted under this Agreement immediately upon written
notice if Customer: (a) exceeds the scope of the license or otherwise fails to comply with the licensing or confidentiality
provisions of this Agreement, or (b) becomes insolvent, files a bankruptcy petition, institutes proceedings for liquidation or
winding up or enters into an agreement to assign its assets for the benefit of creditors. For any other material breach of any
provision of this Agreement, Mentor Graphics may terminate this Agreement and/or any license granted under this Agreement
upon 30 days written notice if Customer fails to cure the breach within the 30 day notice period. Termination of this Agreement or



any license granted hereunder will not affect Customer’s obligation to pay for Products shipped or licenses granted prior to the
termination, which amounts shall be payable immediately upon the date of termination.

12.2. Upon termination of this Agreement, the rights and obligations of the parties shall cease except as expressly set forth in this
Agreement. Upon termination, Customer shall ensure that all use of the affected Products ceases, and shall return hardware and
either return to Mentor Graphics or destroy Software in Customer’s possession, including all copies and documentation, and
certify in writing to Mentor Graphics within ten business days of the termination date that Customer no longer possesses any of
the affected Products or copies of Software in any form.

13. EXPORT. The Products provided hereunder are subject to regulation by local laws and United States (“U.S.”) government agencies,
which prohibit export, re-export or diversion of certain products, information about the products, and direct or indirect products thereof,
to certain countries and certain persons. Customer agrees that it will not export or re-export Products in any manner without first
obtaining all necessary approval from appropriate local and U.S. government agencies. If Customer wishes to disclose any information
to Mentor Graphics that is subject to any U.S. or other applicable export restrictions, including without limitation the U.S. International
Traffic in Arms Regulations (ITAR) or special controls under the Export Administration Regulations (EAR), Customer will notify
Mentor Graphics personnel, in advance of each instance of disclosure, that such information is subject to such export restrictions.

14. U.S. GOVERNMENT LICENSE RIGHTS. Software was developed entirely at private expense. The parties agree that all Software is
commercial computer software within the meaning of the applicable acquisition regulations. Accordingly, pursuant to U.S. FAR 48
CFR 12.212 and DFAR 48 CFR 227.7202, use, duplication and disclosure of the Software by or for the U.S. government or a U.S.
government subcontractor is subject solely to the terms and conditions set forth in this Agreement, which shall supersede any
conflicting terms or conditions in any government order document, except for provisions which are contrary to applicable mandatory
federal laws.

15. THIRD PARTY BENEFICIARY. Mentor Graphics Corporation, Mentor Graphics (Ireland) Limited, Microsoft Corporation and
other licensors may be third party beneficiaries of this Agreement with the right to enforce the obligations set forth herein.

16. REVIEW OF LICENSE USAGE. Customer will monitor the access to and use of Software. With prior written notice and during
Customer’s normal business hours, Mentor Graphics may engage an internationally recognized accounting firm to review Customer’s
software monitoring system and records deemed relevant by the internationally recognized accounting firm to confirm Customer’s
compliance with the terms of this Agreement or U.S. or other local export laws. Such review may include FlexNet (or successor
product) report log files that Customer shall capture and provide at Mentor Graphics’ request. Customer shall make records available in
electronic format and shall fully cooperate with data gathering to support the license review. Mentor Graphics shall bear the expense of
any such review unless a material non-compliance is revealed. Mentor Graphics shall treat as confidential information all information
gained as a result of any request or review and shall only use or disclose such information as required by law or to enforce its rights
under this Agreement. The provisions of this Section 16 shall survive the termination of this Agreement.

17. CONTROLLING LAW, JURISDICTION AND DISPUTE RESOLUTION. The owners of certain Mentor Graphics intellectual
property licensed under this Agreement are located in Ireland and the U.S. To promote consistency around the world, disputes shall be
resolved as follows: excluding conflict of laws rules, this Agreement shall be governed by and construed under the laws of the State of
Oregon, U.S., if Customer is located in North or South America, and the laws of Ireland if Customer is located outside of North or
South America. All disputes arising out of or in relation to this Agreement shall be submitted to the exclusive jurisdiction of the courts
of Portland, Oregon when the laws of Oregon apply, or Dublin, Ireland when the laws of Ireland apply. Notwithstanding the foregoing,
all disputes in Asia arising out of or in relation to this Agreement shall be resolved by arbitration in Singapore before a single arbitrator
to be appointed by the chairman of the Singapore International Arbitration Centre (“SIAC”) to be conducted in the English language, in
accordance with the Arbitration Rules of the SIAC in effect at the time of the dispute, which rules are deemed to be incorporated by
reference in this section. Nothing in this section shall restrict Mentor Graphics’ right to bring an action (including for example a motion
for injunctive relief) against Customer in the jurisdiction where Customer’s place of business is located. The United Nations
Convention on Contracts for the International Sale of Goods does not apply to this Agreement.

18. SEVERABILITY. If any provision of this Agreement is held by a court of competent jurisdiction to be void, invalid, unenforceable or
illegal, such provision shall be severed from this Agreement and the remaining provisions will remain in full force and effect.

19. MISCELLANEOUS. This Agreement contains the parties’ entire understanding relating to its subject matter and supersedes all prior
or contemporaneous agreements. Some Software may contain code distributed under a third party license agreement that may provide
additional rights to Customer. Please see the applicable Software documentation for details. This Agreement may only be modified in
writing, signed by an authorized representative of each party. Waiver of terms or excuse of breach must be in writing and shall not
constitute subsequent consent, waiver or excuse.

Rev. 140201, Part No. 258976


	Table of Contents
	Chapter 1 Introduction
	Product Overview
	Learning ReqTracer

	Chapter 2 Starting ReqTracer
	Main Window
	Menu Bar
	Toolbar
	Project Workspace
	Status Bar

	Configuration Dialog Box

	Chapter 3 Managing Requirements
	Creating a Project
	Adding a Document
	Adding a Covering Document
	Using the Management View

	Chapter 4 Analyzing Requirements
	Analyzing the Project
	Using the Coverage Analysis View
	Adding a Cover

	Using the Impact Analysis View
	Modifying a Document
	Adding a Second Downstream Document
	Reviewing the New Documents
	Performing Impact Analysis

	Using the Graphical View

	Chapter 5 Generating Reports
	Generating a Built-in Report

	End-User License Agreement
	Documentation Feedback

